Geometer’s Sketchpad’e Genel Baks

BOLUM1

GEOMETER’S SKETCHPAD’E GENEL BAKIS

Geometri yolculuguna ¢ikmadan once bize eslik edecek ara¢ hakkinda genel
bir bakis agisi kazanacagiz. Bu boliimde ogrenici Geometer’s Sketchpad
progranu ile tamgtirilacaknr.
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KITABIN AMACI

Kitabmn en 6nemli amact Geometri Sketchpad Programininin galisma
mekanizmasini 6grenmek ve bunun yaninda diger 6nemli bir amaci ise bu
dinamik programin geometriye nasil katkilar sagladigini ve neler
kesfedilebilecegi hakkinda bilgi sahibi olmaktir. Bu programin dinamikligi,
Ogrencilerin varsayimlari test ederken geometrik sekiller olusturmalarina ve
iizerinde degisiklikler yapmalarina olanak saglar. Dinamik bir geometri
yazilimi olan Geometri Sketchpad’ dgrencilerin;

» geometrik kavramlar1 anlamalarina ve 6zelliklerini kesfetmelerine,
> daha ileri ki smiflarda geometri bilgileri sayesinde tanimlar1 ve
teoremleri formiile edebilmelerine,
» Ogrencilerin geometrik sekiller olusturmalarima ve iizerinde
degisiklikler yapmalarina,
> Ilkégretim birinci ve ozellikle ikinci kademede, cesitli geometrik
sekiller cizerek onlarin tanmimlarimi, 6zelliklerini, aralarindaki
iligkiler ile dl¢gme ve yapilandirma yontemlerini kavrayabilmelerine,
olanak saglar. Ayrica lise Ogrencilerine yonelik olarak da geometrik
sekillerin 6zellikleri tizerine ispat liretmeye motive eder.

GEOMETER’S SKETCHPAD NEDIR?

Geometer’s Sketchpad (Geometri ¢izim programi, GSP), geometrik
iligkileri kesfetmek icin ¢ok giiclii bir aracgtir. GSP programini kullanarak
bircok geometrik sekilleri, teoremler ile ilgili modelleri, perspektif cizimleri,
grafik cizimleri yapilabilir. Programin dinamikligi sayesinde bir sekil
cizdikten sonra, bir yerden baska bir yere fare yardimiyla kaydirilabilir. Aym
zamanda geometrik sekillerin bigimleri degistirilebilir. Bir dogru parcasinin
orta noktasini bulmak, bir dogrunun baska bir dogruya paralel veya dik
olmasini belirlemek, verilen bir uzunlugu kendisine yaricap kabul edebilen
¢cember olusturmak, aci, uzunluk, ¢evre, alan gibi hesaplamalar GSP ile ¢cok
daha kolay yapilabilir.

Sketchpad, tiim diinyada geometri konusunda 6ncii kabul edilen bir
geometri ¢izim programidir. Bu program ile .gsp ve .jsp (JavaSketchpad)
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uzantili uygulamalar ve sunumlar hazirlanabilinir. Geometri konulari
daha anlagilir hale gelebilir.

Geometer’s Sketchpad programini http://www.keypress.com/ adresinden
satin alabilir ya da aym adresten 30 giinlik deneme siiriimiinii
indirebilirsiniz. Benzerlerinin aksine sadece birka¢c MB’ lik boyutuyla
indirilmesi ve kurulmasi kolaydir. Ayrica sistem gereksinimleri diigiik olan
bir program oldugundan en diisiik sistemlere bile kurulabilir. Program
giincellestirilmelerle kendini siirekli yeniledigi icin, gelismeleri yakindan
takip edebilen bir program olarak kargimiza ¢ikmaktadir.

Programu yiikleyip agtiginizda ekran goriintiisiiniin bu denli basit olmasi
sizi sasirtmasin. Bu programin en énemli artilarindan birisi de kullanici ara
yiiziiniin basitligidir. Diger geometri yazilimlarini incelediginizde karsiniza
citkan diigmeler ve fonksiyonlar icinde bogulabilirsiniz. Basit birkag
diigmeden olusan cok islevli arag kutusu, size cok profosyonel galigmalar
yapmaniz icin olanak saglar.
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BOLUM2

GEOMETER’S SKETCHPAD ILE CALISMAYA BASLAMAK
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Bu boliimde ogreniciye GSP ‘nin ¢alisma alani, Araclar kutusu ve iglevleri,
Menii bilesenleri ve ozellikleri ornek uygulamalar esliginde anlatilacaktir.
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CALISMA ALANI

Geometri Sketchpad
programimi  agtigimizda

File Edt Display Construdt Transform Measore Graoh ‘Window Held

ekrana meniilerin, araclarin
ve beyaz  bir alanin
bulundugu bir sayfa =
gelecektir. Sayfanin | - s
biiyiikliigiinii istedigimiz gibi
ayarlayabiliriz. = Her  bir
Skecthpad  sayfas1  kendi
penceresi ile birlikte
Sketchpad’ in ana penceresi
icinde yer alir. Ayni anda
birden fazla sayfanin aktif
olmast mimkiindir.
Yukarida iki tane sayfa ayni
anda aktif durumdadir.

Geometer’s Sketchpad iki ana bilesenden olugsmaktadir. Bu bilesenler
Menii cubugu ve sol tarafta bulunan Arag cubugudur.

ARAC KUTUSU

¥

Sketchpadi agtigimizda sol tarafta geometride kullanilan
sekillerin bulundugu hareket edebilir bir ara¢ kutusunu
gorebiliriz. Ara¢ kutusunun hareketliligini kenarindan mause ile
tutup istedigimiz yere birakarak gorebiliriz.

N[C)

Bu ara¢ kutusundan ¢izmek istedigimiz herhangi bir sekil icin
onun iizerine fare ile gelip tikladigimizda arag¢ kutusunun daha
koyu renkli hal alip secili duruma geldigini rahatlikla gorebiliriz.
Ayrica her bir aracin ismini fare imlecini yavasca araglar
iizerinde gezdirerek 0grenebilirsiniz. Yandaki sekilde de goriildiigii gibi su
anda ok isareti olan arag segili durumdadir. Eger secili durumda bulunan
ara¢ butonuna gelip mause ile bir siire basili olarak tutarsak hemen yanda
bu aracin diger opsiyonlar1 da gelecektir. Bunlari daha sonra ornekler
iizerinde anlatacagimiz icin simdilik bu kadariyla yetinelim. Artik bu kutuda
bulunan tiim araclarin tek tek ne ise yaradiklarini 6grenmenin tam sirasi.

¥ |
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—I SECME VE YER DEGISTIRME ARACI
(SELECTION ARROW TOOL)

Bu arag herhangi bir sekil yaratmakta kullanilmaz ancak 6nceden yaratilmig
olan sekilleri segmeye ve onlari bir yerden baska bir yere tasimaya yarayan
aractir. Aracin 6zelliklerini yaptigi isler iizerinde anlatalim.

v" Noktalar siiriikkleme iglemi
Oncelikle bu aracimizi secelim ve daha sonra sketchpad sayfamizda
onceden cizdigimiz herhangi bir noktanin iizerine mause’ umuzla gelip
noktanin iizerinde basili tutarak noktayr sayfanin bagka bir bolgesine
siiriikleyelim, nokta bagka bir yere taginmis oldu. Aymi islemi cemberin
iizerinde herhangi bir noktaya, cemberin merkez noktasina ya da bir dogru
parcasimnin uclarindaki noktalara yapabiliriz.

Asagida cemberin iizerinde bulunan noktayr secme tusuyla tutup
stiriikledigimizde ¢emberde meydana gelen degismeyi gosteriliyor.
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v Bir dogru parcasini ya da bir ¢emberin tiimiinii siiriikleme islemi
Ayni aracit kullanarak bu sefer bir seklin tamamini se¢mek isteyelim.
Se¢mek istedigimiz seklin yanina gelelim seklimiz bir dogru pargasi ise
bunun ortalarmma gelip mause ile Ttzerine tiklayip basili durumda
tasidigimizda seklide tasimiz oluruz. Aymi iglemi bir ¢ember iizerinde
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yapmay1 deneseydik, cemberin cevresinin herhangi bir yerine mause ile
tiklayip istedigimiz yere gelinceye kadar basili durumda siiriikklemeye devem
ederek cemberin Olciilerini degistirmeden bir yerden baska bir yere
taginmasini saglayabilirdik.

v'  Birden fazla sekli ayn1 anda se¢me ve siiritkleme islemi
Se¢me aracini kullanarak bir nesnenin bir cemberin bir noktanin veya bir
dogru parcasimin iizerine tikladigimizda nesnenin secili duruma geldigini
farketmigsinizdir. Nesneler secildiklerinde goriiniimlerinde degisme olur.
Eger sayfanizda bulunan nesnelerin tiimiiniin secililik 6zelliginin yok
olmasini istiyorsaniz, sayfanin herhangi bog bir yerinde tiklama islemini
yapmaniz yeterli olacaktir. Bir nokta, dogru ya da c¢emberi secmeyi
denediginizde nesnenin 151kl hale geldigini goreceksiniz. Eger bir veya daha
fazla sekil secili durumdayken baska bir sekle tikladiginizda, en son
tikladiginiz sekil digerlerinin secililik 6zelligi kaybolmadan secili hale
gelecektir. Eger birden cok sekli secili hale getirmek istiyorsaniz bu yolu
kullanabilirsiniz. Ayrica bagka bir yol da se¢cmek istedigimiz nesnelerin
hepsini kaplayacak sekilde mause’ unuzu basili tutarak sekilleri i¢ine alan
bir alan yaratmaktir. Boylece biraktigimizda olusturdugumuz alan icinde
kalan sekillerin hepsi birden secili hale gelecektir. Bu yol daha pratiktir
ancak secme iglemi dortgensel bolgede oldugu icin bazi istenmeyen
sekillerin de secilmesi miimkiin olabilmektedir.
Eger sadece bir sekli segmek istiyorsak sayfanin bos bir yerine tiklama yapar
ve daha sonra se¢cme araci aktif iken seklin iizerine gelip seklimizi seceriz.

J NOKTA OLUSTURMA ARACI (POINT TOOL)

Arag¢ kutusundan nokta olusturma aracini bir tiklama yardimiyla seciniz.
Daha sonra mause‘ unuzu basili halde olmadan sayfaniza dogru siiriikleyin
ve nerede nokta olmasmu istiyorsaniz o noktada mause’ unuza tiklama
yapiniz. Her tiklamaniz bir nokta olusturacaktir.

Ql CEMBER OLUSTURMA ARACI (COMPASS TOOL)

Arac kutusundan ¢cember olusturma araci iizerine tiklayiniz. Sayfaniza
gelin ve bosg bir alanda mause ile tiklama yapin. Nasil bir sekil olustu?
Burada olusan sadece bir noktadir. Cember olusturma araci siiriikleme
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islemiyle calisir. Yine sayfada bos bir yere gelin ve cemberinizin merkezi
olmasini istediginiz yerden baglayarak mause’ unuza basin ve basili tutarak
hareket ettirin cemberinizin olustugunu goézlemleyebilirsiniz ve istediginiz
biyiikliige ulagincaya kadar siiriikleme islemini devam ettirin. Cember
olustugunda ilk baslangic noktaniz ve en son biraktiginiz nokta olmak iizere
iki noktanin varhgma dikkat edin. Bu iki 06zel nokta c¢emberin
biyiikligiiniin tanimlanmasinda rol oynarlar. Degisik biiyiikliikte cemberler
olusturarak iki noktanin dnemi kavrama caligin.

J DOGRU PARCASI OLUSTURMA ARACI
(STRAIGHTEDGE TOOL)

Bu aracimizda ¢ember aracinin caligma prensibi gibi siiriikleme mantigi
ile calsir. Araclar kutusundan Dogru Parcast olusturma butonuna
tiklayiniz. Sayfanizda bos bir yere gelin ayni gember olustururken yaptigimiz
gibi baslangic noktasi olmasini istediginiz bir yere tiklayin ve mause’ unuzu
kaldirmadan siiriikleme islemini devam ettirin. Biraktiginiz anda dogru
parganiz olugmug ve bunun birlikte basladiginiz nokta ile bitis noktaniz da
dogru pargasinin iki u¢ noktasi halinde olacaktir.

NOKTALI DOGRU OLUSTURMAK

Herhangi bir dogruyu noktali hale getirmek icin ¢izdiginiz dogru iizerinde
sag tiklayin acilan sekmede “Dashed” ozelligine tiklarsaniz, Dogrunuzun

kesikli ¢izgili hale gelecegini gorebilirsiniz.

 The Geometer’s Sketchpad - [Untitled 1] 3 The Geometer’s Sketchpad - [Untitled 1]
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VAROLAN NOKTALARLA ARACLARI KULLANMAK

Simdiye kadar nokta dogru pargasi
ve cemberleri birbirinden bagimsiz @ The Geometer's Sketchpad - [Untitled 1]
rastgele olarak olusturduk. Simdi ise Fle Edt Display Conswuct Transform | Mea:
var olan sekillere baglantili olacak [
sekilleri  olusturmay1r  G6grenecegiz.
Birbirine baglantili olan sekilleri her
olusturdugumuzda  Se¢gme  tusuna
tiklayarak figlirii  stiriikleme  testi
yapacagiz ve gercekten birbirine bagh
olup olmadigin1 gorecegiz. Daha 6nce
yaptigimiz rastgele sekil olusturma
calismasinda olusturdugumuz noktalar, cemberler ve dogru parcalar
bulunmaktadir.

-

>Nl |

> Bu noktalardan iki tanesini se¢in. Hemen sonra araclar kutusundan
Cember Olusturma aracint secin ve iki noktadan hangisinin baslangig
noktasi olacagina karar verdikten sonra o noktadan baslayarak farenizi
basili tutun ve diger noktaya ulastiginizda nokta isikli halde gelecektir,
mause’ a basmayi birakin. Olusan ¢emberimiz de daha Onceden sec¢mis
oldugumuz iki noktanin birincisi ¢emberimizin merkezi duruma gelmis
oldu.

» Bir dogru parcasini belirleyin. Araglar kutusundan ¢cember
olusturma aracini secin. Dogru parcasinin iki noktasindan bir tanesini
baslangi¢ noktasi secin ve daha sonra buradan mause’ unuza basili tutarak
diger uca dogru siiriiklemeye baglayin, noktaya ulastiginizda nokta 11kl
hale gelecektir. Artik mause’ a basmayi birakabilirsiniz. Burada dogru
parcamiz artik gemberimizin yaricapini belirtir hale geldi. Eger noktalardan
birini siiriiklerseniz, cemberin ve dogru pargasinin ayni anda degistigini
gorebilirsiniz.

» Bir dogru parcasi belirleyin. Araclar kutusundan dogru parcasi
olusturma aracini secin. Sayfada belirlemis oldugunuz dogru parcasmin
iizerine gelin ve tam {iizerindeyken seklin 1sikli hale geldigini géreceksiniz
151kl haldeyken mause ile tiklayp siiriiklemeye baglayin ve bitmesini
istediginiz zaman mause’ u birakin. Yeni olusturdugumuz dogru pargasi iki
tane noktaya sahiptir. Ikinci yani en son olusan nokta bagimsiz olarak

10




Geometer’s Sketchpad Ile Calismaya Baslamak

hareket ettirilebilir, fakat birinci nokta
yani baglangic noktas: sadece orijinal
olan segment iizerinde hareket edebilir.

X,
Bir cember  belirleyin.  Araclar .
kutusundan dogru pargasi olusturma ©)
aracini  seginiz. Cemberin igine ug 7
noktalar1 ¢emberin izerinde olacak A
sekilde bir dogru parcasi cizin. Ilk énce »
gember {izerine gelin ve cemberin :

1siklandig1 anda mause ile tiklayin ve karst yaya dogru siiriiklemeye baglaymn
¢cemberin 1siklandigini gordiigiiniiz anda mause’ u birakin.

€ The Geometer’s Skeichpad [Untitled 1]
File Edit Display Construct Transform Mea:

UCGEN CiziMi
» File meniisiinden New Sketch’e tiklayarak yeni bir sayfa

aciniz. Daha sonra Dogru Parcasi olusturma butonuna J tiklayiniz.

€ The Geometer's Sketchpad - [Untitled 1]
Fle Edt Display Corstruct  Transform  Mead

» Bir Dogru Parcasi ¢iziniz. Bu N

dogru pargasinin iki tane uc noktasi vardir. , /

e

¥

O The Geometer's Sketchpad - [Untitled 1
> Bu uc noktalardan bir tanesini File Edit Display Construck Transhorm  Me

se¢in ve izerine geldiginizde 151810 N,

Yandigina dikkat edin, 151k yanarken fare ye o
basmaya baslaymn ve siiriikkleyin. Uygun bir
yerde birakin.

EIEMN[C
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» Ucgenimizin son kenarini
birlestirmeye geldi sira. Bunu yapabilmek i¢in kenari olusturacagimiz yerin
iki u¢ noktasi olacak olan noktalarin herhangi birine fare ile gidin ve 151k
yandiginda fare ile basih halde siiriiklemeye baglaymn, diger noktaya
ulastiginizdan emin olmak icin 15181n yanip yanmadigina dikkat edin.

Not: Olusturdugumuz iiggenin sorunsuz olusup olugmadigini anlamak
icin licgenin noktalarm da tutup siiritklemeye baslaym, eger tiggenin formu
icgen olma Ozelligi bozuluyorsa bu noktalarin birbirine tam olarak
birlestirilemedigini sdyler daha dikkatli yapmay: deneyin.

Simdi de {iggenin kenarlarimi adlandirma iglemini yapalim Bunun igin yazi
olusturma aracini bilmemiz gerekiyor.

A

£ * METIN ARACI (TEXT TOOL)

Bir nesneyi etiketlendirmek igin araglar kutusundan Metin Araci secilir.
Biitiin nesneler aslinda bir etikete sahiptir, ancak bunlar gizli durumdadur.
Yazi yazma aracini seciniz ve etiketlendirmek istediginiz noktanin iizerine
geliniz. Noktanin iizerine geldiginizde mause’un el seklinin koyu renk
olduguna dikkat ediniz, bu bize etiketlemeyi yapacagimiz zamani belirtir.
Tam burada Mause’ a tikladigimizda noktanin etiketlendigini goérebiliriz.
Etiketlenmis noktanin iizerine tekrar bastigimizda etiket ortadan
kaybolacaktir. Bunu noktada yapabildigimiz gibi bir dogru parcasinda veya
bir cemberde de yapabiliriz. Noktalara konulan etiketlerin biiyiik harfli
kenarlara koyulan etiketlerin ise kiigiik harfli olduguna dikkat ediniz.

Etiketin adini degistirmek icin etiketin lizerine cift tiklayiniz. Bunu
yaptiginiz zaman karsiniza bir dialog kutusu cikacaktir.

12
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Properties of Point A @

Object Label |
Laled
@
¥ Show Label Syle..
-
Yarcien | intal | T amam l

Burada Label yazan kisimda A’ nin yerine baska bir harf yazabiliriz.
Yazimizin stilini, fontunu, biyiikliigiini ve daha bircok Ozelligini de
degistirebiliriz.

© The Geometer's Sketchpad - [Untitled 1]
File Edt Display Construct Transform Meas

Se¢me tusunuz secili haldeyken etiketin iizerine dogru geldiginizde yine el
isaretinin belirdigini ve yine cift tiklama ile diolog kutusuna ulagabilirsiniz.

KARISIKLIGI DUZENLEMEK VE SILMEK

Ik olusturdugumuz rastgele sekiller cizdigimiz sayfada karisik bircok sekil
bulunmakta. Bu karmagikliktan nasil kurtulacagiz?

v Yeni Bir Sayfa
ABC iiggenini olustururken zaten bu islemi yapmustik. File>New Sketch de

yeni bir sayfaya ulasmistik ancak diger sayfa hala gérmedigimiz halde acgik
bulunmaktadir. Bu sayfay1 kapatabilir ya da kaydetme islemini yapabiliriz.

v Geri almak
Eger ki Edit meniisiinden Undo secenegini secersek bu bizi en son
yaptigimiz islemeden bir Onceki isleme gotirecektir. Boylece en son
yaptigimiz hatamizi silmis ve eskiden devam etmis gibi oluruz.

13
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v' Nesneleri secmek ve silmek

Karisikliga neden olan eger kompleks bir sekilse ya da sayfada bulunmasim
istemedigimiz sekil yada sekiller mevcutsa bunu o sekilleri secip silerek
sorundan kurtulabiliriz. Bildigimiz gibi eger birden fazla sekli secmek
istiyorsak bunu siiriikkleme yardimiyla, nesnelerimizi dikddrtgen icine
alarak onlar1 secili hale getirebiliriz. Daha sonra Delete ya da Edit
meniisiinden Cut secenegine tiklayarak silme islemini tamamlayabiliriz. Bir
sayfada bulunan tim sekillerden kurtulmak istiyorsak bunu da Edit-> Select
All segeneginden yararlanarak tiim nesnelerin secili duruma gelmesini
saglayabilir ve daha sonra Delete ile sayfamizi temizleyebiliriz. (Eger Select
All aktif halde degilse aracimizin se¢me araci olarak isaretli oldugunu
kontrol edelim.)

v Nesneleri gizlemek
Sectigimiz nesneleri silebildigimiz gibi onlar1 gizleyebiliriz de. Bu islem
nesne secildikten sonra Display Menii’den Hide ile saglanir. Gizleme islemi
sik sik kullanilan 6nemli bir iglemdir.

BITiSIK CEMBERLER VE ESKENAR UCGEN
Eskenar bir ticgene ¢cemberler yardimiyla nasil ulasabiliriz?
> Yeni bir sayfa acin. (File=> New Sketch)

> Bir ¢cember olusturunuz. Bu ¢cemberle ayni1 yarigap: paylasan bir
diger cemberi olusturmak icin ilk cemberin bitim noktasindan baslayarak
merkezine dogru siiriikleyin ve tam merkezde 151k yandiginda birakin olugan
sekil agagidaki gibidir.

© The Geometer's Sketchpad - [Untitled 1]

Seklimizin birbirine baglantili oldugunu = |8 Fie & oslar Contrt Transform e
anlamak icin secme araciyla sekli siiriikleyin ||,
eger  sekillerinde  degisme  olmadan :
stiriiklenebiliyorsa seklimiz birbiriyle
baglantilidir.
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£ The Geometer's Sketchpad - [Untitled 1]
Fiz Edit Display Construct Transform Meas

> Iki cemberin kesim noktasmi
olusturmak icin iki ¢emberi de segin ve IT
Construct-> Intersections’ a tiklayin kesim
noktalar1 ekranda belirecektir.

o

Q) The Geometer's Sketchpad - [Untitled 1]

Fle Edt Disglay Construct Transform Mea:

> Iki cemberin merkezlerini A ve B
olarak etketlendirdikten sonra A ve B | |M
noktalarimi birlestirin. (A ile B noktalarn
segilir ve Construct—> Segment yapilir.)

A
\/

EAZNCIR

Q The Geometer's Sketchpad - [Untitled 1]

» Iki cemberin kesim noktasindan Fio B Eck MDisclzy M Construc B rensfomll Mess

birini C olarak etiketlendirin daha sonra A
ile C noktasina bir dogru pargasi ¢izelim.(A
ile C noktalarin secip, Construct ->Segment

ile parcay: elde ettik. Ayni iglemi de B ve C g
noktasina uyguladiktan sonra olusan sekil bir A’
eskenar ticgendir ve su bicimdedir. »

Not: Seklin dogru olarak olusturuldugundan emin olmak icin A, B ve C
noktalarindan tutup siiriikkleyin eger sekilde bir bozulma s6z konusuysa
birlestirme tam yapilmamis demektir.

e Sekli noktalarindan tutup siiriiklediginizde neler oldu?

Tiim yap1 ayn1 anda ayn1 oranda biiyiidii veya kiiciildii bu 6rnek programin
dinamikliginin bir kanitidir.
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